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Disposal of your old appliance
1. When this crossed-out wheeled bin symbol is attached to a product it means
the product is covered by the European Directive 2002/96/EC.
2. All electrical and electronic products should be disposed of separately from
the municipal waste stream via designated collection facilities appointed by
the government or the local authorities.
3. The correct disposal of your old appliance will help prevent potential negative
consequences for the environment and human health.
4. For more detailed information about disposal of your old appliance, please contact
your city office, waste disposal service or the shop where you purchased the product.
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Introduction
Congratulations on your purchase of
the advanced and compact KG290
mobile phone, designed to operate
with the latest digital mobile
communication technology.

Introduction
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This user’s guide contains important
information on the use and
operation of this phone. Please read
all the information carefully for
optimal performance and to prevent
any damage to or misuse of the
phone. Any changes or modifications
not expressly approved in this user’s
guide could void your warranty for
this equipment.

For Your Safety
Please read these simple guidelines.
Not following these guidelines may
be dangerous or illegal. Further
detailed information is given in this
manual.

CAUTION!
• Switch off the phone in any area
where required by special regulations.
For example, do not use your phone in
hospitals or it may affect sensitive
medical equipment.
• Emergency calls may not be available
under all mobile networks. Therefore,
you should never depend solely on
your mobile phone for emergency calls.
• Only use ORIGINAL accessories to
avoid damage to your phone.
• All radio transmitters carry risks of
interference with electronics in close
proximity. Minor interference may
affect TVs, radios, PCs, etc.
• Batteries should be disposed of in
accordance with relevant legislation.
• Do not dismantle the phone or battery.

For Your Safety

WARNING!
• Mobile Phones must be switched off
at all times in aircrafts.
• Do not hold the phone in your hand
while driving.
• Do not use your phone near petrol
stations, fuel depots, chemical plants
or blasting operations.
• For your safety, use ONLY specified
ORIGINAL batteries and chargers.
• Do not handle the phone with wet
hands while it is being charged. It may
cause an electric shock or seriously
damage your phone.
• Keep the phone in a safe place out of
small children’s reach. It includes small
parts which, if detached, may cause a
choking hazard.

• Not to charge a handset near
flammable material as the handset
can get hot and smoulder the Material,
hence possible house fire.

7

Guidelines for Safe and Efficient Use
Please read these simple guidelines.
Not following these guidelines may
be dangerous or illegal. Further
detailed information is given in this
manual.

Guidelines for Safe and Efficient Use
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Certification information
(SAR)
THIS DEVICE MEETS
INTERNATIONAL GUIDELINES
FOR EXPOSURE TO RADIO
WAVES
Your mobile device is a radio transmitter
and receiver. It is designed and
manufactured not to exceed the limits for
exposure to radio frequency (RF)
recommended by international guidelines
(ICNIRP). These limits are part of
comprehensive guidelines and establish
permitted levels of RF energy for the

general population. The guidelines were
developed by independent scientific
organizations through periodic and
thorough evaluation of scientific studies.
The guidelines include a substantial
safety margin designed to assure the
safety of all persons, regardless of age
and health.
] The exposure standard for mobile

devices employs a unit of
measurement known as the Specific
Absorption Rate, or SAR. The SAR
limit stated in the international
guidelines is 2.0 W/kg*. Tests for SAR
are conducted using standard
operating positions with the device
transmitting at its highest certified
power level in all tested frequency
bands. Although the SAR is
determined at the highest certified
power level, the actual SAR of the

] This device meets RF exposure

guidelines when used either in the
normal use position against the

ear or when positioned at least
1.5 cm away from the body.
When a carry case, belt clip or
holder is used for body-worn
operation, it should not contain
metal and should position the
product at least 1.5 cm away from
your body. In order to transmit
data files or messages, this device
requires a quality connection to
the network. In some cases,
transmission of data files or
messages may be delayed until
such a connection is available.
Ensure the above separation
distance instructions are followed
until the transmission is
completed. The highest SAR value
for this device when tested for use
at the body is 1.01 W/kg.

Guidelines for Safe and Efficient Use

device while operating can be well
below the maximum value. This is
because the device is designed to
operate at multiple power levels so as
to use only the power required to
reach the network. In general, the
closer you are to a base station, the
lower the power output of the device.
Before a phone model is available for
sale to the public, compliance with the
European R&TTE directive must be
shown. This directive includes as one
essential requirement the protection
of the health and the safety for the
user and any other person.
The highest SAR value for this device
when tested for use at the ear is
0.752 W/kg.
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Guidelines for Safe and Efficient Use

Guidelines for Safe and Efficient Use
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* The SAR limit for mobile devices
used by the public is 2.0
watts/kilogram (W/kg) averaged
over ten grams of body tissue.
The guidelines incorporate a
substantial margin of safety to give
additional protection for the public
and to account for any variations in
measurements. SAR values may
vary depending on national
reporting requirements and the
network band. For SAR information
in other regions please look under
product information at
www.lgmobile.com.

Product care and
maintenance
WARNING!
Only use batteries, chargers and
accessories approved for use with this
particular phone model. The use of any
other types may invalidate any approval
or warranty applying to the phone, and
may be dangerous.
] Do not disassemble this unit. Take

it to a qualified service technician
when repair work is required.
] Keep away from electrical

appliances such as a TV's, radios
or personal computers.
] The unit should be kept away from

heat sources such as radiators or
cookers.
] Never place your phone in a

microwave oven as it will cause
the battery to explode.

] Do not drop.
] Do not subject this unit to

mechanical vibration or shock.
] The coating of the phone may be

damaged if covered with wrap or
vinyl wrapper.
as alcohol, benzene, thinners, etc.)
or detergents to clean your phone.
There is a risk of this causing a
fire.
] Do not subject this unit to

excessive smoke or dust.
] Do not keep the phone next to

credit cards or transport tickets; it
can affect the information on the
magnetic strips.
] Do not tap the screen with a sharp

object as it may damage the
phone.

or moisture.
] Use accessories, such as

earphones and headsets, with
caution. Ensure that cables are
tucked away safely and do not
touch the antenna unnecessarily.
] Please remove the data cable

before powering on the handset.

Electronic devices
All mobile phones may get
interference, which could affect
performance.
] Do not use your mobile phone

near medical equipment without
requesting permission. Avoid
placing the phone over
pacemakers. (i.e. in your breast
pocket.)

Guidelines for Safe and Efficient Use

] Do not use harsh chemicals (such

] Do not expose the phone to liquid
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Guidelines for Safe and Efficient Use
] Some hearing aids might be

disturbed by mobile phones.
] Minor interference may affect TVs,

radios, PCs, etc.

] RF energy may affect some

electronic systems in your motor
vehicle such as a car stereo or
safety equipment.
] If your vehicle is equipped with an

Road safety
Guidelines for Safe and Efficient Use
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Check the laws and regulations
on the use of mobile phones in
the areas when you drive.

air bag, do not obstruct it with
installed or portable wireless
equipment. It can cause serious
injury due to improper
performance.

] Do not use a hand-held phone

while driving.
] Give full attention to driving.
] Use a hands-free kit, if available.
] Pull off the road and park before

making or answering a call if
driving conditions so require.

Blasting area
Do not use the phone where blasting
is in progress. Observe restrictions,
and follow any rules or regulations.

Potentially explosive
atmospheres
] Do not use the phone at a

refueling point. Don't use near fuel
or chemicals.

Children
Keep the phone in a safe place out
of small children's reach. It includes
small parts which if detached may
cause a choking hazard.

] Do not transport or store

In aircraft
Wireless devices can cause
interference in aircraft.
] Turn off your mobile phone before

boarding any aircraft.
] Do not use it on the ground

without crew permission.

Emergency calls
Emergency calls may not be
available under all mobile networks.
Therefore, you should never depend
solely on your mobile phone for
emergency calls. Check with your
local service provider.

Guidelines for Safe and Efficient Use

flammable gas, liquid, or
explosives in the compartment of
your vehicle, which contains your
mobile phone and accessories.
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Guidelines for Safe and Efficient Use

Battery information and
care
] You do not need to completely

Guidelines for Safe and Efficient Use
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discharge the battery before
recharging. Unlike other battery
systems, there is no memory
effect that could compromise the
battery's performance.
] Use only LG batteries and

chargers. LG chargers are
designed to maximize the battery
life.
] Do not disassemble or short-circuit

the battery pack.
] Keep the metal contacts of the

battery pack clean.

] Replace the battery when it no

longer provides acceptable
performance. The battery pack
may be recharged hundreds of
times until it needs replacing.
] Recharge the battery if it has not

been used for a long time to
maximize usability.
] Do not expose the battery charger

to direct sunlight or use it in high
humidity, such as the bathroom.
] Do not leave the battery in hot or

cold places, this may deteriorate
the battery performance.
] Risk of explosion if battery is

replaced by an incorrect type.
] Dispose of used batteries

according to the manufacturer’s
instructions.

KG290 Features
Parts of the phone
Front view

Rear view
Antenna
Earpiece

Holes for a
carrying strap
Camera lens

Front
screen

Battery

SIM card
External
socket
memory
slot

Note
] Never touch the antenna during a

KG290 Features

Navigation keys

call. It may degrade speech quality.
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KG290 Features
Left side view

Right side view

Side keys
] In

standby mode
(open/closed):
Keypad volume adjustment.
] During a call: Earpiece
volume adjustment.
Camera hot key

KG290 Features
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Headset

Open view
Navigation keys
] In standby mode:
Briefly: Write new
Message (Hold down: present
Messages pop-up)
Briefly: List of Contacts
Briefly: List of Profiles
(Hold down: Activate/
Deactivate Vibrate mode)
Briefly: List of Favourites
] In menu: scroll up & down

Send key

Earpiece
Main screen
] Top: Icons showing

signal strength, battery
level and various other
functions
] Bottom: Soft key
indications

Left soft key/
Right soft key
] These keys perform

the function Indicated in
the bottom of the display.

] Dials a phone number

Confirm key

and answers a call.
] In standby mode: Shows
a history of calls made,
received and missed.

] Selects menu options

End/Power Key

] In standby mode: Input

Clear key

numbers to dial. Hold down:
for international calls.
to dial voice mail centre.
to
for speed dials.
] In editing mode:
Enter numbers & characters.

] Deletes a character

with each press.
Hold the key down to
clear all input. Use
this key to go back to
a previous screen.

KG290 Features

Alpha numeric keys

and confirms actions.
] WAP access (long key)
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KG290 Features

Display Information
Icon area

The screen displays several icons.
These are described below.

On-Screen Icons
Text and
graphic area
Menu

Area

Right key
indicators

Description

Displays various
icons.
Middle lines Display messages,
instructions and any
information that you
enter, such as
number to be dialled.
Last line
Shows the functions
currently assigned to
the two soft keys.

First line
KG290 Features
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Contact

Icon/Indicator Description
Tells you the strength of
the network signal.
You can use GPRS
service.
The alarm has been set
and is on.
The bluetooth is set to
On.
The schedule has been
set.
Tells you the status of
the battery.
You have received a text
message.

Icon/Indicator Description
You have received a
voice message.
Vibrate only menu in
profile.
Silent menu in profile.
General menu in profile.
Outdoor menu in profile.

Note
] The quality of the conversation may

change depending on network
coverage. When the signal strength
is below 2 bars, you may experience
muting, call drop and poor audio.
Please refer to this signal as an
indicator for your calls. When there
are no bars, that means that there is
no network coverage: in this case,
you won’t be able to access the
network for any service (call,
messages and so on).

Headset menu in profile.

Indicates that the phone
is accessing WAP.

KG290 Features

You can divert a call.
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Getting Started
Installing the SIM card
and battery

card, press down lightly and pull it in
the reverse direction.

1. Installing the SIM card.
Your SIM card contains your phone
number, service details and contacts
and must be inserted into your
handset.

Getting Started
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If your SIM card is removed then
your handset becomes unusable
(even the emergency calls) until a
valid one is inserted. Always
disconnect the charger and other
accessories from your handset
before inserting and removing your
SIM card. Slide the SIM card into the
SIM card holder.
Make sure that the SIM card is
properly inserted and the gold
contact area on the card is facing
downwards. To remove the SIM

To insert the SIM card

To remove the SIM card

Note
] The metal contact of the SIM card

can easily be damaged by scratches.
Pay special attention to the SIM
card while handling. Follow the
instructions supplied with the SIM
card.

2. Installing the battery.
Insert the battery aligning the gold
contacts on the battery with the
battery terminals (gold contacts) in
the battery compartment. Then push
down the top of the battery until it
snaps into place.
Getting Started
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Getting Started
3. To remove the battery.
Turn the power off. (If the power is
left on, there is a chance you could
lose the stored telephone numbers
and messages.) Press the battery
release latches  and open the
battery . Then remove the battery.

Getting Started
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Charging the Battery
Before connecting the travel adapter
to the phone you must first install
the battery.

2. Connect the other end of the travel
adapter to the mains socket.

Note
] Only use the charger included in the

box.

3. The moving bars on the battery
icon will stop after charging is
complete.
4. Ensure the battery is fully charged
before using the phone for the first
time.

Getting Started

1. With the arrow facing you as
shown in the diagram push the
plug on the battery adapter into
the socket on the left side of the
phone until it clicks into place.
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Getting Started
CAUTION!
• Do not force the connector as this may
damage the phone and/or the travel
adapter.
• If you use the battery pack charger
when abroad, use an attachment plug
adaptor for the proper configuration.
• Do not remove your battery or the SIM
card while charging.

Getting Started
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WARNING!
• Unplug the power cord and charger
during lightning storms to avoid
electric shock or fire.
• Make sure that no sharp-edged items
such as animal teeth or nails, come
into contact with the battery.
This may cause a fire.

Disconnecting the
charger
Disconnect the travel adapter from
the phone as shown in the diagram
below.

Access codes

PIN2 code (4 to 8 digits)

You can use the access codes
described in this section to avoid
unauthorised use of your phone.
The access codes (except the PUK
and PUK2 codes) can be changed by
using the Change codes feature
[Menu 9.6.6].

The PIN2 code, supplied with some
SIM cards, is required to access
functions such as Fixed Dial
Number. These functions are only
available if supported by your SIM
card.

PIN code (4 to 8 digits)

The PUK (PIN Unblocking Key) code
is required to unlock a PIN blocked
phone. The PUK code may be
supplied with the SIM card.
If not, contact your network operator
for the code. If you lose the code,
also contact your network operator.

Getting Started

The PIN (Personal Identification
Number) code protects your SIM
card against unauthorised use.
The PIN code is usually supplied
with the SIM card. When the PIN
Code Request is set to On, your
phone will request the PIN code
every time it is switched on. When
the PIN Code Request is set to Off,
your phone connects to the network
directly without the PIN code.

PUK code (4 to 8 digits)
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Getting Started
PUK2 code (4 to 8 digits)
The PUK2 code, supplied with some
SIM cards, is required to unlock a
blocked PIN2 code. If you lose the
code, please contact your network
operator.

Security code (4 to 8 digits)

Getting Started
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The security code prevents
unauthorised use of your phone.
The default security code is set to
‘0000’ and the security code is
required to delete all phone entries
and to restore the handset to the
factory settings.

General Functions
Making and answering
calls
Making a voice call
1. Enter the number including the full
area code, or select the phone
number from call logs by pressing
.
] To delete a digit press

.
To delete all digits press and
hold
.

2. Press

to make the call.

Making a voice call from
Contacts or close the handset
It is easy to call anyone whose
number you have stored in your
Contacts.

to access the contacts

2. Scroll to the contact to make a
call.
3. Press

to make a voice call.

4. Press

to finish the call.

Making international calls
1. Press and hold
for the
international prefix. The ‘+’
character prefixes the
international access code.
2. Enter the country code, area code,
and the phone number.
3. Press

.

Adjusting the volume
During a call, if you want to adjust
the earpiece volume, use on the
left side of the handset.

General Functions

3. Press
to finish the call, or
close the handset.

1. Press
list.
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General Functions
In idle mode with the phone open,
you can adjust the key volume
using .

Answering a call
When you receive a call, the phone
rings and the flashing phone icon
appears on the screen. If the caller
can be identified, the caller’s phone
number (or name if stored in your
Contacts) is displayed.

General Functions
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1. Open the phone and press
to
answer an incoming call. If the
answer mode is set to Press any
key, any key will answer a call
except for
.

Note
] To reject an incoming call, press

or the right soft key twice.
] If you set Answer mode as Slide

open (Menu 9.5.2), you can answer
the call simply by opening the
phone.

2. End the call by closing the handset or
pressing
.
Note
] You can answer a call while using

Contacts or other menu features.
] When the compatible headset is

connected, you can also answer a
call using the headset key, as well
as using the phone. To reject an
incoming call, press
.
] You can mute the ringtone when a

call comes in by pressing and
holding the volume down side key.

Signal strength
You can check the strength of your
signal by the signal indicator (
)
on the left top of your phone screen.
Signal strength can vary, particularly
inside buildings. Moving close to a
window may improve reception.

Entering text

This mode lets you enter words
with only one keystroke per
letter. Each key on the keypad
has more than one letter. The T9
mode automatically compares
your keystrokes with an internal
dictionary to determine the
correct word, thus requiring far
fewer keystrokes than the
traditional ABC mode. This is
sometimes known as predictive
text.

ABC mode
This mode lets you enter letters
by pressing the key labelled with
the required letter once, twice,
three or four times until the letter
is displayed.

General Functions

You can enter alphanumeric
characters using the keypad.
For example, storing names in
Contacts, writing a message,
creating a personal greeting or
scheduling events in the calendar
all require entering text.
The following text input methods are
available with the handset.

T9 mode
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General Functions
123 mode (Number mode)
Type numbers using one
keystroke per number.
To change to 123 mode in a text
entry field, press
until 123
mode is displayed.

Changing the text input mode

General Functions
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1. When you are in a field that
allows characters to be entered,
you will notice the text input mode
indicator in the upper right corner
of the LCD screen.
2. Press
to switch between
T9Abc, T9abc, T9ABC, ABC, Abc,
abc and 123.

Using the T9 Mode
The T9 predictive text input mode
allows you to enter words easily
with a minimum number of key
presses. As you press each key,
the handset begins to display the
characters that it thinks you are
typing based on a built-in dictionary.
As new letters are added, the word
changes to reflect the most likely
candidate from the dictionary.
1. When you are in the T9 predictive
text input mode, start entering a
word by pressing keys
to
. Press one key per letter.
] The word changes as letters are

typed. Ignore what’s on the
screen until the word is typed
completely.

] If the word is still incorrect after

typing completely, press
once or more to scroll through
the other word options.
Example
Press
to type
Good.
Press to get Home.
] If the desired word is missing

from the word choices list, add
it by using the ABC mode.
2. Enter the whole word before
editing or deleting any keystrokes.

To delete letters, press
Press and hold down
entire words.

.
to erase

Use

to

to enter your text.

1. Press the key labelled with the
required letter:
] Once for the first letter.
] Twice for the second letter.
] And so on.

2. To insert a space, press
once. To delete letters, press
. Press and hold down
to clear the display.
Refer to the following table for more
information on the characters
available using the alphanumeric
keys.

General Functions

3. Complete each word with a space
by pressing
.

Using the ABC Mode

31

General Functions
Key

Characters in the order display

Using the 123 (Number) mode

Upper Case

Lower Case

.,/?!-:'"@1

.,/?!-:'"@1

The 123 mode enables you to enter
numbers in a text message
(a telephone number, for example).
Press the keys corresponding to the
required digits before manually
switching back to the appropriate
text entry mode.

ABC2ÀÂÆÇ

abc2àâæç

DEF3ÉÈÊË

def3éèêë

GHI4ÎÏ

ghi4îï

JKL5

jkl5

MNO6ÑÔÖŒ

mno6ñôöœ

PQRS7

pqrs7

TUV8Û

tuv8û

ˆ Yˆ
WXYZ9W

wxyz9w
ˆ yˆ

Space, 0

Space, 0

Note
] The characters assigned to the keys

General Functions
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and their order of appearance
depends on the language selected
using the option Input method. The
table above provides the characters
set for English language.

Using the symbol mode
The symbol mode enables you to
enter various symbols or special
characters. To enter a symbol,
Options > Add > Symbol.
Use the navigation and numeric keys
to select the desired symbol
and press .

Overview of Menu Functions
You can launch a menu by pressing
in the idle screen. Move to the desired
item and press
to go into the sub menu.
From the main menu you can also go into a submenu by directly pressing the
corresponding numeric key as follows. The main menu consists of the following
top menus and sub menus.
NOTE: The menu in this phone can be displayed in 2 ways. One is by grid type or
secondly in list format. Please note that menu number options are different in
each view. The default setting on the phone is set to show the menu in grid type,
so therefore all the menu number selections throughout the manual are set
according to that setting.

2. Call history

1.1 Orange World

2.1 All calls

3.1 Alarm clock

1.2 Bookmarks

2.2 Missed calls

3.2 Calendar

1.3 Enter URL

2.3 Dialled calls

3.3 Calculator

1.4 History

2.4 Received calls

3.4 Memo

1.5 Saved pages

2.5 Call duration

3.5 To do

1.6 Settings

2.6 Call costs

3.6 Stopwatch

1.7 Information

2.7 Data information

3.7 Unit converter
3.8 World time

Overview of Menu Functions

3. Tools

1. Orange World

3.9 Interactive
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Overview of Menu Functions
4. Multimedia
4.1 MP3 player
4.2 Camera
4.3 Video camera
4.4 FM radio
4.5 Voice recorder

Overview of Menu Functions

34

5. Messaging
5.1 New message
5.2 Inbox
5.3 Drafts
5.4 Outbox
5.5 Sent
5.6 Listen voicemail
5.7 Info messages
5.8 Templates
5.9 Settings

6. My stuff
6.1 Images
6.2 Sounds
6.3 Videos
6.4 Others
6.5 Games & Apps
6.6 External memory

7. Profiles
7.1

General

7.2

Silent

7.3

Vibrate only

7.4

Outdoor

7.5

Headset

8. Contacts
8.1 Search
8.2 New contact
8.3 Speed dials
8.4 Groups
8.5 Copy all
8.6 Delete all
8.7 Settings
8.8 Information

9. Settings
9.1 Date & Time
9.2 Languages
9.3 Display
9.4 Connectivity
9.5 Call
9.6 Security
9.7 Flight mode
9.8 Power save
9.9 Reset
9.0 Memory status

Orange World
Orange World

Menu 1.1

You can launch the web browser and
access the homepage of the web
service provided by your Service
Provider.

Bookmarks

Menu 1.2

You can store frequently accessed or
favourite URLs/Pages. Several
preconfigured URLs are stored as
bookmarks.

Connecting to a desired
bookmark
Press or select Connect from the
Options menu.
Adding a new folder
1. Select New folder from the
Options menu.
2. Enter the title.
3. Press the left key [OK] to save.

Enter URL

Menu 1.3

You can manually enter a URL
address and access the associated
web page.

2. Enter the title and associated URL
information.

] To enter a symbol, press

3. Press the left soft key [OK] to save.

] To switch input mode, press

to

display the Symbol table.
.

Orange World

Adding a new bookmark
1. Select New Bookmark from the
Options menu.
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Orange World

History

Menu 1.4

Shows the list of web page's titles
accessed recently. You can access
the web page easily.

Saved pages

Menu 1.5

The phone can save the page on
display as an offline file.

Settings
Orange World
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Menu 1.6

You can change the settings for
browser display, security, and
certificates.

Network profiles

(Menu 1.6.1)

Select the appropriate profile by
pressing . This will activate the
profile to initiate the browser launch.

View style

(Menu 1.6.2)

You can change the browser screen
size. (Full screen or fit to screen)

Cache

(Menu 1.6.3)

Enabling Cache allows you to store
accessed pages to your phone. Once
a page has been stored in the cache
it will greatly enhance the page
loading speed on subsequent
browsing of the same page.

Cookies

(Menu 1.6.4)

Enabling Cookies allows you to store
cookies sent from the server.
Disabling this function will prevent
cookies from being stored on your
phone.

Security Certificates

(Menu 1.6.5)

If stored, a list of root/ca certificates
required for WTLS/TLS can be found
here. Certificates can be viewed
from the list.

Show image

(Menu 1.6.6)

Allows you to enable or disable the
image display during browsing.
Note
] Enabling this function will delay

(Menu 1.6.7)

This menu allows you to activate the
Java Script while you use the web
browser.

Memory in use

(Menu 1.6.8)

You can select a memory to
use.(Phone or External)

Information

Menu 1.7

You can check the version of your
browser.
Orange World

displaying images until the
completion of transmission.
Disabling this function will prevent
the browser from downloading
images from the server, thus
allowing faster transmission.

Java script
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Call history
You can check the record of missed,
received, and dialled calls only if the
network supports Calling Line
Identification (CLI) within the service
area.
The number and name (if available)
are displayed together with the date
and time at which the call was
made.

All calls

Call history
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Menu 2.1

Allows you to view the missed,
received, and dialled call records.
You can make a call or send a
message to the number you have
selected from the records. You can
also save the number in the
Contacts.

Missed calls

Menu 2.2

Allows you to view missed call
records, make a call, send a
message and save the number in
Contacts.

Dialled calls

Menu 2.3

Allows you to view dialled call
records, make a call, send a
message and save the number in
Contacts.

Received calls

Menu 2.4

Allows you to view received call
records, make a call, send a
message and save the number in
Contacts.

Call duration

Menu 2.5

Call costs

Menu 2.6

This function allows you to view the
duration of your Last call, Dialled
calls, Received calls and All calls in
hours, minutes and seconds. You can
also reset the call timers.

This function allows you to check
the cost of your last call, all calls,
remaining and reset the cost.
To reset the cost, you need the PIN2
code.

1. Press the left soft key [Menu] and
then press
for direct access
or use and to enter Call
history.

1. Press the left soft key [Menu] and
then press
for direct access
or use and to enter Call
history.

2. Scroll to Call duration and Press
[OK].
The following 4 submenus:
Last call, Dialled calls,
Received calls and All calls.

2. Scroll to Call costs and Press
[OK].
The following 3 submenus:
Last call, All calls and Cost
settings.
] The actual cost invoiced for calls by

your service provider may vary,
depending upon network features,
rounding-off for billing, tax, and etc.

Call history

Note
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Call history

Data information

Menu 2.7

You can check the Data time and
Data volume.

Call history
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Tools
Alarm clock

Menu 3.1

If you set the alarm, the
appears
on the indicator bar. The specified
alarm sounds at the scheduled time.
Press right soft key [Quit] to stop the
alarm, and the alarm is released.
Press the left soft key [Snooze]. The
alarm sound stops and resumes after
the selected Snooze duration. You
can configure up to 5 alarms.
1. Select your desired alarm to
configure in the alarm list. If there
is no alarm, press the right soft
key [New] to add a new alarm.

3. Input alarm time: Input your
desired alarm time by specifying

4. Select repeat mode: Select the
desired repeat mode using /
or select the desired one from the
list by pressing
.
5. Select Alarm Tone: Select the
alarm tone to ring at the alarm
time opening the list by pressing
the left soft key [Options] >
Sounds
6. Title: Input alarm name.
7. When you have finished setting
the alarm, press the left soft key
[Save].
Note
] The alarm will go off even when the

Tools

2. Set/Cancel alarm: Set or cancel
the alarm using the options for
specifying whether the alarm is on
or by choosing the alarm time.

Hour and Minute. Choose either
‘AM’ or ‘PM’ which is visible if 12
hour format is specified for the
phone.

phone is switched off.

41

Tools

Calendar

Menu 3.2

You can refer to your schedule by
months. The cursor is on the current
date, and the registered date is
marked.
The schedule saved for the date
where the cursor is located is
represented by an icon. Pressing the
shortcut key
moves to the
previous year and pressing
move to the next year. Pressing
moves to the previous month, and
moves to the next month. You
can move the date using the /
/ / .

Tools
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You can enter a schedule or memo in
the scheduler by pressing the left
soft key [Options].

] View: Shows the schedule note or

memo for the chosen day. Press
the left soft key [Options] to edit or
delete the note you selected.
] New schedule: Select this to

enter a new schedule or memo.
After a schedule note is entered
on a date, a special mark is shown
on the date and
appears on
the left bottom of the screen. This
function reminds you of your
schedule. And the phone will
sound an alarm tone if you set the
phone to do so.
] Scheduler tone: Adjust the

Scheduler tone.
] All schedules: Shows all the

notes that are entered in the
phone. Use the up/down
navigation keys to browse through
the note lists.

] Go to date: Shows schedule of

the date you put.

2. Select the appropriate function.

] Delete more

- Delete old: Select this to delete
the expired schedule notes that
you have already been notified
of.
- Delete all: Select this to delete
all the schedule notes and
memos.

Calculator

1. Press the left soft key.

Menu 3.3

Whenever you hold
down, all
the characters are deleted in reverse
order in one go.
When calculation is complete and
the result is displayed on the screen,
pressing a symbol saves the result
into the symbol and continues
calculation.
Tools

The calculator module allows you to
perform basic arithmetic functions
such as addition, subtraction,
multiplication, and division as well
as some scientific functions.

You can enter numbers by using the
number keys, and the operators by
using the / / / direction
keys. You can enter a decimal point
by pressing
. Whenever you
press
, characters are
sequentially deleted in reverse order.
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Tools

Memo

Menu 3.4

Using the memo management
function, you can view and manage
saved memo contents and add new
memo.
Enter the contents of the memo.
You can save the memo to the list by
pressing the [OK] key.

Add memo
To add a new memo, press the left
soft key [Options] and select New
memo. Enter the contents of the
memo. You can save the memo to
the list by pressing the left soft key
[Options] and select Save or just
press the .
Tools
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Edit and delete memo
Highlight the desired memo and
press to view its contents.

You can edit or delete the contents
of a memo using the left soft key
[Options]. You can select Multiple or
All memos using the Mark/Unmark
option and then delete a memo.

To do

Menu 3.5

You can view, edit and add tasks to
do. Tasks are displayed in time order.
Tasks that have been completed or
not completed are displayed in
different ways.

Options
] View: To view detailed task
contents, locate the cursor on the
desired item in the Tasks list, and
then press .
] New to do: To input the date,

description and priority for the task

and input the status. When you
have finished entering the data,
press the left soft key [Save] key
to save the new task.
] Status: You can view the status of

task selected.
] Send via: You can send the

selected task via Text message,
Picture message or Bluetooth.
] Delete: You can delete the task.

You can display the tasks in progress
or completed.
] Edit: You can edit a task using the

left key [Otions].
] Calendar: You can view tasks of

the day selected.
Multiple or All complete tasks
to delete. And you can delete old
tasks or all.

Menu 3.6

1. Press [Start] to take time and
record the lap time by pressing
[Lap].
2. Press [Stop] to ascertain the
record of lap time.
3. Press [Reset] to default condition.

Unit converter

Menu 3.7

Using this menu, users can convert
Currency, Area, Length, Weight,
Temperature, Volume and Velocity.

Currency

(Menu 3.7.1)

1. Select Currency menu.
2. Select the desired unit.
3. Enter the standard unit and view
the converted value.

Tools

] Delete more: You can select

Stopwatch
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Tools
4. To exit Currency conversion
function, press [Back] key.

Weight

Area

2. Select the desired unit.

(Menu 3.7.2)

3. Enter the standard unit and view
the converted value.

1. Select Area menu.
2. Select the desired unit.
3. Enter the standard unit and view
the converted value.

4. To exit the Weight conversion
function, press the [Back] key.

4. To exit the Area conversion
function, press [Back] key.

Temperature

Length

2. Position the cursor on the desired
unit by using the up or down
arrow keys.

(Menu 3.7.3)

1. Select the length menu.
2. Select the desired unit.
3. Enter the standard unit and view
your converted value.
Tools
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(Menu 3.7.4)

1. Select the Weight menu.

4. To exit the length conversion
function, press the [Back] key.

(Menu 3.7.5)

1. Select the Temperature menu.

3. Enter the standard unit and view
the converted value.
4. To exit the Temperature conversion
function, press the [Back] key.

Volume

(Menu 3.7.6)

1. Select the Volume menu.
2. Select the desired unit.
3. Enter the standard unit and view
the converted value.
4. To exit the volume conversion
function, press the [Back] key.

Velocity

(Menu 3.7.7)

1. Select the Velocity menu.
2. Select the desired unit.
3. Enter the standard unit and view
the converted value.
4. To exit the Velocity conversion
function, press the [Back] key.

World time

Menu 3.8

The World clock function provides
time information on major cities
worldwide.
You can view the time of the desired
country or city by navigating using
/ .
You can select a desired city as a
base by selecting the Change city
menu in options.

Interactive

Menu 3.9

This is a SIM service menu.
It depends on SIM and the network
services.
Note
SAT(i.e. SIM Application Toolkit)
services, this menu will be
the operator specific service name
stored on the SIM card.

Tools

] In case the SIM card support
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Multimedia
MP3 player
All songs

Menu 4.1

(Menu 4.1.1)

You can view all the music files
stored in the phone/external
memory.

My playlist

(Menu 4.1.2)

You can create your own playlists by
choosing tracks from the All tracks
menu list.

Settings
Multimedia
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Repeat
(Menu 4.1.3.2)
If you select One, only one song you
selected will be repeated. And all
the songs in your playlist will be
repeated if you select All. And no
repeat and play just one song in case
of selecting No.
Equalizer
(Menu 4.1.3.3)
You can choose the equalizer among
several genres of music. Jazz, Rock,
Pop, etc.

(Menu 4.1.3)

Shuffle
(Menu 4.1.3.1)
If you want to play the music
continuously and randomly, select
this option.

Player skin
(Menu 4.1.3.4)
There are 3 kinds of player skin and
you can change it as you want.

Note
] Because of the small dimension of

the speaker, the audio could be
distorted in some cases.
Especially when there are lots of
bass sounds and the audio memory
volume is at the maximum state.
We recommend you to use the
stereo headset in order to
appreciate the music of high quality.

] By using the USB cable, you can

connect your phone to PC and
transfer MP3 files to the phone
(removable disk). You should quit the
connection via safe removal mode
after you finish copying songs to
your phone.

] The music player supports following

file formats,
- MPEG-1 Layer III, MPEG-2 Layer III,
MPEG-2.5 Layer III
(Bit rate up to 320Kbps, stereo)
- AAC: ADIF, ADTS
AAC+: V1(Bit rate 16~128Kbps),
V2(Bit rate 16~48Kbps)

- WMA(Bit rate up to 320Kbps,
stereo)
* Sampling frequency: 8KHz~48KHz
for each format

Multimedia

- MP4, M4A(Bit rate up to 320Kbps,
stereo)
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Multimedia

Camera

Menu 4.2

Press the Menu key and select Camera using the navigation keys. Or you can
directly open the camera module by a press of the Camera key in standby
mode. The camera module opens and you’ll see the view to be captured.
indicator

Options

Album

1. Press the left soft key to access Menu and set the desired environment as follows.
Multimedia

] Brightness setting: Move between the options menus with
] Zoom setting: Select the desired value with

with the left soft key or

/

/

.

and confirm the selection

.

Note
] The zoom function varies depending on the resolution the camera is set to.
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For example, if the camera resolution is set to the highest setting you can't zoom.

Resolution

1280X960, 640x480, 320x240

Quality

Normal, Fine, Super fine

Self timer

You can delay the camera shutter time.
Off, 3 Secs, 5 Secs, 10 Secs
“ ” is shown when the timer is activated.

View mode

You can view Full image or Full screen.
Save the photos to your Phone or External memory.

Multi shot

1 shot , 3 shots, 6 shots
(Note: Available multishot depends on the size.)

Effect

Off, Sepia, Mono, Negative

White
balance

You can adjust the tone of the background photo
according to the weather.
Auto, Daylight, Incandescent, Cloudy, Fluorescent

Shutter tone

Select the desired shutter sound. Off, Tone1, Tone2, Tone3

Reset setting

Select the reset setting or not

2. After finishing all the settings, press the right soft key [Close].
3. Focus the camera on what you want to take and press
.
4. Press
to save the picture. It is saved in the Images folder of My stuff.

Multimedia

Save to
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Multimedia

Video camera

Menu 4.3

This application enables you to record a video clip. You can play and watch a
saved video file in this menu. Once recorded, a video clip can be sent by
Message or Bluetooth.

Options

Press the

Album

to record the image.

Multimedia

1. Press the left soft key to access Options and set the desired environment as
follows.
] Brightness setting: Move between the options menus with
] Zoom setting: Select the desired value with

selection with

.
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X

144

/

/

.

and confirm the

Mode

Record a video in General/MMS mode.

Resolution

176X144, 128X96

Quality

Normal, Fine, Super fine

Save to

Save the video clips to your Phone or External memory.

Effect

Off, Sepia, Mono, Negative.

White
balance

You can adjust the tone of the background video
according to the weather.
Auto, Daylight, Incandescent, Cloudy, Fluorescent

Reset setting

Reset all the settings or not.

2. After finishing all the settings, press the right soft key [Close].
3. Focus the camera on what to record and press
And press
to stop recording.

to start recording.

to save the video clip. It is saved in the Videos folder of My stuff.

Note
] Press the right soft key [Back] to go back to the preview mode without saving the

Multimedia

] You can pause the recording by pressing the left soft key [Pause].

4. Press

video clip.
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Multimedia

FM radio

Menu 4.4

If you press options, you can view
the menus as follow:
] Edit channel: You can edit the

selected channel.
] Auto scan: You can search for

available channels by scanning
automatically.
] Reset channels: You can reset

the channels.

Multimedia
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Title

Descriptions

Frequency

Shows the frequency
indicating the current
cursor.

Volume

Controlling the volume

Channel

FM frequency and
channel number
which is now playing

] Listen via: You can listen the FM

radio via speaker or headset.

Voice recorder

Menu 4.5

In this feature you can record over 10
voice memos, up to a maximum of
60 seconds each.

Messaging
New message
Text

Menu 5.1

] Sound: You can insert sounds that

(Menu 5.1.1)

] Text templates: You can use Text

You can write and edit text
messages up to 10 pages.
1. Enter the Text menu by pressing
[OK].
2. To make text input easier, use T9.
For details, refer to page 21
through 24 (Entering text).
3. Press [Options > Insert] to
attach the following:

Insert
characters.
] Image: You can insert the Default

graphics or graphics in My
pictures that are available for
short messages.

templates already set in the
phone.
] Contacts: You can add phone

numbers or e-mail addresses in
the address book.
] My business card: You can add

your Business card to the
message.
4. After you have completed the
message, to select the required
option, press the left soft key
[Options].

Options
] Send to: Sends text messages.

1. Enter numbers of recipient. Also,
you can select Options and choose

Messaging

] Symbol: You can add special

are available for short messages.
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Messaging
from Contacts, or Recent
messages to send a text message.
2. Press
key to add more
recipients.

Messaging
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3. Once the numbers have been
entered, press the left soft key
to send the message.
All messages will automatically be
saved in the outbox folder, even
after a sending failure.
] Save to drafts: Stores messages
in the Drafts folder.
] T9 languages: Select the desired
language for T9 input mode.
] Clear text: You can delete all of
the words written.
] Exit: If you press Exit whilst
writing a message, you will be
taken back to the message menu.
Also the written message will not
have been saved.

Note
] This phone supports EMS release 5,

so is available to send colour
pictures, sounds, text styles, etc..
If the other parties handsets do not
support such options, the pictures,
sounds or texts sent may not be
displayed correctly on their phones.

Picture

(Menu 5.1.2)

A multimedia message can contain
text, image, and/or sound clip.
1. Enter the Multimedia menu by
pressing
[OK].
2. To make text input easier, use T9.
3. Press [Options > Insert] to
attach following:

Insert
] Symbol: You can add special

characters.

] Image: You can insert the Default

graphics or graphics in My
pictures that are available for
short messages.
] Video: You can insert videos that

are available for short messages.
] Sound: You can insert sounds that

are available for short messages.
] New photo/video/sound: You

can insert new multimedia files
that you create instantly to the
short messages.
] New slide: You can insert a new

sheet of slide before or after
current slide.
templates already set in the
phone.

numbers or e-mail addresses in
the address book.
] My business card: You can add

your Business card to the
message.
Maxium available file size, that can
be inserted to MMS-message, is
300kb.
4. After you have completed the
message, to select the required
option, press the left soft key
[Options].

Options
] Send to: You can send multimedia

messages to multiple recipients,
as well as save it to send al a later
time.

Messaging

] Text templates: You can use Text

] Contact: You can add phone
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Messaging
] Preview: You can preview

multimedia message you have
created.
] Save: You can save multimedia

messages To drafts or As
template.
] T9 languages: You can choose

languages and also deactivate the
T9 input mode by selecting 'T9
off'.
] New T9 word: You can add a

new word to dictionary. (This
menu is only shown when the T9
input mode is set ON.)
] Others: You can set a slide

Messaging
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Inbox

Menu 5.2

You will be alerted when you have
received messages. They will be
stored in the Inbox.
In the Inbox, you can identify each
message by their icons. For detail,
see the icon directive.
] Icon directive

Icon Description
Multimedia message
Read Multimedia message
Short message
Read Short message

duration or delete slide or edit
subject.

Notified multimedia message

] Exit: Will take you back to the

Read notified multimedia message

Message menu.

If the phone shows ‘No space for
SIM message’, you only have to
delete the SIM messages from the
Inbox. If the phone displays ‘No
space for message’, you will then
need to delete messages, media or
applications to free up space.
Note
] SIM message: SIM message

means the message is exceptionally
stored in the SIM card.

] View: You can view the selected

message.
] Reply: You can reply to the

sender.
] Delete: You can delete the current

message.
] Forward: You can forward the

selected message to another
party.
] Return call: You can call the

sender back.

To read a message, select one of the
messages by pressing
.

] Save number: You can save the

message's number.
] Information: You can view

information about received
messages; Sender's address,
Subject (only for Multimedia
message), Message date & time,
Message size.

Messaging

When you are notified that you have
received a multimedia message, you
have to wait for the message to be
downloaded before you can view it.
For notification setting, see (Menu
5.9.2.7) for detail.
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Messaging
] Multi delete: You can delete

multiple messages together.

message from the drafts folder.

] Delete all read: You can delete

all the read messages.
] Delete all: You can delete all the

messages.

Drafts

Messaging

Each draft has the following options.
Press [Options].
] View:

You can view the
selected message.

] Edit: You can edit the selected

message.

] Information:

You can view the
information of selected message:
subject (only for multimedia
message), the date and time when
saved, message size.

] Multi delete: You can delete
Menu 5.3

You can view the messages saved as
a draft. The draft messages are
listed with the date and time when
they were saved. Scroll through the
list using up/down navigation keys.
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] Delete: Deletes the selected

multiple messages together.
] Delete all: You can delete all the

messages.

Outbox

Menu 5.4

The Outbox is a temporary storage
place for messages waiting to be
sent. Failed messages are also
placed in the Outbox.
] View: You can view the message.
] Delete: You can delete the

message.
] Forward: You can resend the

message.
] Edit: You can edit the message.
] Information: You can check the

information of each message.
] Delete more

- Delete all: You can delete all
the messages in the outbox.

Menu 5.5

Shows the messages you sent
(Message).

Options
] View: Opens the selected

message.
] Delete: Deletes the current

message.
] Forward: Forwards the selected

message.
] Information: Brief information on

the message.
] Multi delete: You can delete

multiple messages together.
] Delete all: You can delete all the

messages.

Messaging

- Multi delete: Deletes selected
drafts at one time.

Sent
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Messaging

Listen voicemail

Menu 5.6

This menu provides you with a quick
way of accessing your voice mailbox
(if provided by your network). Before
using this feature, you must enter
the voice mail number obtained from
your network operator.
When a new voice message is
received, the
symbol will be
displayed on the screen. A long
press of the
key will take you
directly into your voicemail. Please
check with your service operator for
details of their service in order to
configure the handset correctly.
Messaging
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Info messages

Menu 5.7

(Dependent to network and
subscription)
Info service messages are text
messages delivered by the network
to your handset. They provide
general information such as weather
reports, traffic news, taxis,
pharmacies, and stock prices.
When you receive an info service
message, you will see a popup
message show you that or the info
service message is directly
displayed. To view the message
again follow the sequence shown
below;

Read

(Menu 5.7.1)

] Active list: You can select info

service message numbers in the
active list. if you activate an info
service number, you can receive
messages sent from the number.

1. When you have received an info
service message and select Read
to view the message, it will be
displayed on the screen. You can
read another message by scrolling
,
or
[OK].

Templates

2. The message will be shown until
another message is selected.

Text

Topic

(Menu 5.7.2)

] View list: You can see Info

(Menu 5.8.1)

You can add, edit, and delete
frequently used useful phrases using
the left soft key [Options].
Note
] Depending on your service provider,

useful phrases are saved as a
default.

The followings are pre-defined text
templates.

Messaging

service message numbers which
you have added. If you press
[Options], you can edit and delete
info message categories which
you have added.

Menu 5.8
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Messaging
• Please call me back.

] Delete: Deletes the selected

template from the text template
list.

• I’m late. I will be there at
• Where are you now?
• I am on the way.

Use this to
create a new template.

• Very urgent! Please contact
me.

]

• I love you.

Multimedia

The following options are available.

After you have saved a new
template, you can use the following
options.

] View: Select this to view the

selected template.
] Edit: Use this to edit the selected

template.
]

Messaging
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] New template:

Send via
- Text message: Use this to send
the selected template message
by SMS.
- Multimedia message: Use this
to send the selected template
message by MMS.

Delete all: Deletes all templates.
(Menu 5.8.2)

] View:

You can see multimedia
templates.

] Edit:

You can edit multimedia
templates.

] Send:

You can write and send
multimedia messages.

] Delete:

You can delete
multimedia templates.

] New template: Allows you to

add new multimedia templates.
] Delete all:

Allows you to delete
all multimedia messages.

Settings
Text message
]

Menu 5.9
(Menu 5.9.1)

Message types:

Text, Voice, Fax, Natl. paging,
X.400, E-mail, ERMES

] Validity period: This network

service allows you to set how long
your text messages will be stored
at the message centre.

you can check whether your
message is sent successfully.
] Reply charging:

When a
message is sent, it allows the
recipients to reply and charge the
cost of the reply to your telephone
bill.

] Message centre number: Saves

or changes the number of your
SMS centre when sending text
messages. You must obtain this
number from your service provider.

Picture message

(Menu 5.9.2)

] Subject: You can enter

multimedia messages subject
when this menu is on.
] Slide duration: You can set the

Messaging

Usually, the type of message is set
to Text. You can convert your text
into alternative formats. Contact
your service provider for the
availability of this function.

] Delivery report: If you set to Yes,

duration of slides by the second.
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Messaging
] Priority: You can set the priority

of the message you choose.
] Validity period: This network

service allows you to set how long
your text messages will be stored
at the message centre.
] Delivery report: If it is set to Yes

in this menu, you can check
whether your message is sent
successfully.

] Network profiles: If you select

the multimedia message server,
you can set the URL for the
multimedia message server.
] Permitted message type

] Read report: You can check if

- Personal: Personal message.

your message is read by the
recipient. This feature is
dependent on the network.

- Advertisements: Commercial
message.

] Auto download: If you select On,

Messaging
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notification. If you select Home
network only, you will receive
multimedia messages only when
you are registered to your home
network (not roaming).

you will receive multimedia
messages automatically. If you
select Off, you will receive only a
notification message in the inbox
and then you can check this

- Information: Necessary
information.

Voicemail number

Push message

(Menu 5.9.4)

You can set the option whether you
will receive the message or not.

]

(Menu 5.9.5)

Receive
- On: If you select this menu, your
phone will receive Info service
messages.

]

Alert
- On: Your phone will beep when
you have received Info service
messages.
- Off: Your phone will not beep
even though you have received
info service messages.

]

Languages
- You can select the language you
want by pressing
.
Then, the info service message
will be shown in the language
that you have selected.

Messaging

Info message

- Off: If you select this menu, your
phone will not receive Info
service messages any more.

(Menu 5.9.3)

You can receive voicemail if your
network service provider supports
this feature. When a new voicemail
is received, a symbol will be
displayed on the screen. Please
check with your network service
provider for details of their service in
order to configure the phone
accordingly.
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My stuff
Images

Menu 6.1

The Images folder consists of
embedded links for downloading
pictures through the Internet.
Pictures taken using the camera are
stored in the Images folder and you
can create new folders to manage
them.
When a download link is selected,
the following options will be
displayed by pressing the left soft
key [Options].
] View: You can view the picture.
] Set as: You can set as wallpaper

or picture ID(contact image).
My stuff

] File > Information: You can

view the file information.
] Slide show: You can view slide

show.
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] New folder: You can create a

new folder within the folder
currently selected.
] Multi delete: Deletes the

selected image.
] Delete all: Deletes all images.
] Sort by: You can sort the files by

date, type or name.

Sounds

Menu 6.2

Here you can manage, send or set
sounds as ringtones.
When a download link is selected,
the following options will be
displayed by pressing the left soft
key [Options].
] Play: You can play the sound.
] Set as: You can set as ringtone or

ringtone ID(contact ring).

] File > Information: You can

view the file information.
] New folder: You can create a

new folder within the folder
currently selected.
] Multi delete: Deletes the

selected image.
] Delete all: Deletes all images.
] Sort by: You can sort the files by

date, type or name.

Videos

again to start playing.
The followings are available using
the left soft key [Options] in the
Video list.
] Send via: You can send the
selected video clip via Picture
message or Bluetooth if not
protected by Digital Rights
Management (DRM).
] File
- Rename: You can rename the
video.

Menu 6.3

- Move to folder: Moves the file
to other folder.
- Information: Shows information
on the selected video file.
] New folder: You can create a
new folder.
] Sort by: You can sort files by
name, date, or file type.

My stuff

Here you can manage or send
downloaded or captured videos clips.
When a download link is selected,
you can download video clips via the
Internet.
If you press
, you can activate
the video file and press the OK key
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My stuff
] Multi delete: Deletes the

selected video file.
] Delete all: Deletes all video files.

You can view a video using the video
player. Video files are displayed in
the list as thumbnails. You can select
a desired video by using the /
/ / .
Select a desired video and select
Play to view the recorded video.
Select the left soft key [Send] to
attach the selected video to a
message, Email.

My stuff
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When option 1. Open is selected
and you press , the video clip will
be played with the Media Player. To
pause the playback, press
during
the playback. To resume the paused
playback, press
once again.

When viewing video clips in the
Media Player, the following options
are available:
] File > Information: You can

check information on files being
played (File name, Size, Date,
Type, Playback time, Copyright).
] Send via: You can send the video

via Picture message or Bluetooth if
the file is not protected by Digital
Rights Management (DRM).
] Delete: Deletes the selected

video.
Note
] According to your Service Provider, it

varies whether you can download
new Images or Sounds or Videos
etc. through the Internet.

Others

Menu 6.4

Any type of file can be stored here.
This folder is mainly used for
transporting files from one PC to
another.
Note
] You can see only specific files in a

specific folder. That is, files in a
suitable format to each folder are
only shown. (e.g. BMP, JPG, etc.
files for the Images folder and
MP3, WMA, etc. files for the Sound
folder, and so on)

Games & Apps

Games & Apps

(Menu 6.5.1)

• Games: In this menu, you can
manage the Java applications
installed in your phone. You can
play or delete downloaded
applications, or set the connect
option. The downloaded
applications are organised in
folders.
After selecting a folder, press
[Options] and then sub menus
available to several options are
displayed.
] Open: You can see the stored

Menu 6.5

games.
] New folder: Create a new slide.
] Delete all: You can delete all.

My stuff

You can easily download games and
other applications in this menu.
Please note that additional cost may
be incurred when using online
services.
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My stuff

My stuff
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JavaTM, is a technology
developed by Sun Microsystems.
Similar to the way you would
download the Java Applet using
the standard MS Internet
Explorer browsers, Java MIDlet
can be downloaded using a WAP
enabled phone. Depending on
the service provider, all Java
based programs such as Java
games can be downloaded and
run on a phone. Once
downloaded, the Java program
can be viewed in the Games &
Apps menu where you can
select, execute, or delete. The
Java program files saved in the
phone are in .JAD or .JAR
format.

• Applications: In this menu, you
can manage the Java applications
installed in your phone.
You can play or delete
downloaded applications, or set
the connect option.
The downloaded applications are
organised in folders.
Press the left soft key [Options]
and select Open to open the
selected slide or launch the
selected midlet.
Note
] The JAR file is a compressed format

of the Java program and the JAD
file is a description file that includes
all detailed information. From the
network, prior to download, you can
view all detailed file descriptions
from the JAD file.

] While being based on a standard

Network profiles

(Menu 6.5.2)

language (J2ME), not all Java
applications are compatible with all
handsets on sale insofar as specific
libraries may be used for a
telephone model. The software may
be blocked or switch itself on when
Java applications not specifically
developed for the phone this manual
refers to are downloaded, making it
necessary to “restart” the handset.
We would like to point out that
these problems are caused by
incompatible applications and are
not a product fault.

A profile is the network information
used to connect to the Internet.
There are default profiles for some
operators, stored in phone memory.
It’s impossible to rename default
profiles.

CAUTION!
Only J2ME(Java 2 Micro Edition) based
programs will run in a phone
environment. The J2SE(Java 2 Standard
Edition) based programs will only run in a
PC environment.

WAP settings for the selected
profile.

Each profile has submenus as
follows:
] Activate: Activates the selected

profile.
] Edit: Use this to edit and change

My stuff
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My stuff
• Homepage: This setting allows
you to enter the address (URL)
of a site you want to use as
homepage. You do not need to
type http:// at the front of each
URL as the WAP Browser will
automatically add it.
• Proxy: Activates or cancels proxy.
• IP address: Input the IP address
of the Proxy server you access.
• Port number: Input the Proxy
Port.
] New profile: You can add a new

profile.
] Reset all: Reset all the profiles.

My stuff
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External memory

Menu 6.6

By using the USB cable, you can
connect your phone to PC and use
the phone as a mass storage
(Removable Disk). You can transfer
MP3 files, Images and Videos etc. in
your PC to your phone.
Note
] When you format your SD Card, you

should set the file system as FAT
not FAT32. This system doesn't
provide FAT32 file format.

Note
1. This function will only work in the
idle mode.
2. Please do not try to disconnect the
cable while you are transferring
files. After you finish the download,
you should disconnect the cable via
a safe removal mode for a safety of
your phone.
3. If you receive a call when you use
this function, the call will be rejected
but you can find it in a missed call
list after you finish the connection.
4. You can use an external memory
which is up to 2GByte.

My stuff
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Profiles
In Profiles, you can adjust and
customise the phone tones for
different events, environments, or
caller groups. There are five preset
profiles: General, Silent, Vibrate
only, Outdoor and Headset.
Each profile can be personalised
(Except Vibrate only, Silent menu).

Profiles
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Contacts
Search

Menu 8.1

You can see the contact lists. The
search operation is performed based
on a name. You can also perform
some operations by option menu for
the selected phone number; Edit,
Send message, Delete, New contact,
Multi delete, and Copy, etc..

New contact

Speed dials

Groups
Menu 8.2

Menu 8.4

Using this menu you can manage
contacts by grouping the handset stored
contacts. There are 7 default groups you
can make: Family, Friends, Colleagues,
VIP, Group1, Group2, Group3. You can
perform some operations by option menu
for the selected Group; View members,
Group ringtone, Group icon Add member,
Remove member, Remove all member,
Rename, and Reset all. Especially, you

Contacts

You can register a new contact
address. You can enter the name,
different phone numbers and email
addresses of a new contact. You can
also assign the contact to group, and
include a picture and a specific
ringtone. You can see the attached
picture and hear the assigned
ringtone when it's incoming call.

Menu 8.3

Speed dials are configured between
2-9 and set by the information stored
in your SIM card and phone. You can
just check which number is in the
speed dials list and can't manage
them optionally.
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Contacts
can hear the group ringtone for the
contacts you assign to group and group
ringtone.

] Name & number: Set the

phonebook list by displaying the
name and number.
] With picture: Set the phonebook

Copy all

Menu 8.5

You can copy an entry from SIM to phone
or from phone to SIM.

Delete all

Menu 8.6

You can delete all of the contact lists on
SIM or Phone.

Settings
Contacts
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View options

Menu 8.7

(Menu 8.7.1)

] Name only: Set the phonebook

list by displaying the name only.

list with the information and
picture of contact.

Information

Menu 8.8

] Service dial number: Use this

function to access a particular list
of services provided by your
network operator (if supported by
the SIM card).
] Own number: You can save and

check your own number in SIM
card.

] My business card:

This option
allows you to create your own
business card featuring Name and
a mobile phone number. You can
send a business card via the
Multimedia or Text message also.

Contacts
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Settings
Date & Time

Menu 9.1

Many features of your phone can be
customised to suit your preferences.
All of these features are accessed
via the Settings menu.

Set date

2. Select the date format using

/

3. Enter Day, Month and Year using
the number keys.
Settings
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Time format

(Menu 9.1.4)

You can set the time format between
24-hour and 12-hour.

Auto update

.

4. Press the left soft key [OK] to set
the date with the specified value.

You can set the date format.

(Menu 9.1.3)

You can enter the current time.

(Menu 9.1.1)

1. Select the Date item from the
Date & Time list and then
press .

Date format

Set time

(Menu 9.1.2)

(Menu 9.1.5)

When Auto Update is configured to
On, the time and date are
automatically updated according to
the current time zone.

Languages

Menu 9.2

Select the display language. You can
select Automatic language option
to change display language to the
SIM card supported language.

Display

Menu 9.3

This menu allows you to personalise the
display options of the screens and of the
menus entire graphic interface.

Wallpaper

(Menu 9.3.1)

you can enter a specific menu
directly.

Theme

(Menu 9.3.5)

You can change current theme to
other one as you want.

You can select an image to be
displayed on the main screen.

Menu style

Backlight timer

You can select the desired menu
style (Grid view or List view).

(Menu 9.3.2)

(Menu 9.3.6)

You can set the backlight duration on
the Display and Keypad individually.

Standby text

Brightness

If you select On, you can edit the
text which is displayed in standby
mode.

(Menu 9.3.3)

The screen brightness can be
adjusted.
(Menu 9.3.4)

You can display the shortcuts on the
home screen. By using the shortcuts,

(Menu 9.3.8)

If the function is activated,network
name will be displayed on main LCD.

Settings

Network name
Home screen shortcut

(Menu 9.3.7)
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Settings
Colourful dial font

(Menu 9.3.9)

If you select On, the colour of dialing
font get various(not just black
colour).

phone. You can also exchange, for
example, business cards, calendar
items and pictures.
Note
] We recommend that your phone and

Connectivity
Bluetooth

Menu 9.4

(Menu 9.4.1)

Bluetooth connection
Your phone has built-in Bluetooth
wireless technology which makes it
possible for you to connect your
phone wirelessly to other Bluetooth
devices such as a handsfree, PC,
PDA or other phones.
Settings
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You can, for example, have a
conversation via a cordless Bluetooth
handsfree or browse the Internet,
wirelessly connected via a mobile

the Bluetooth device you are
communicating with be within a
range of 10 meters. The connection
may be improved if there are no
solid objects between your phone
and the other Bluetooth device.

1. Getting started
• Menu > 9. Settings >
4. Connectivity > 1. Bluetooth
> 1. Bluetooth on/off
To use the Bluetooth function, you
must first set On.

2. Configuring Bluetooth settings
• Menu > 9. Settings >
4. Connectivity > 1. Bluetooth
> 3. Settings
- My visibility: Set [My handset’s
visibility] to [Show] so that other
devices can detect your phone
when they are searching for a
Bluetooth device. If you select
[Hide], other devices will not be
able to detect your phone when
they are searching for a Bluetooth
device.

- My address: You can check the
address of Bluetooth.

] When user uses Bluetooth Device in

the handset, the security of the
handset is at risk.
Therefore, we recommend that
Bluetooth visibility be set to Hide
after configuration or device pairing.
For incoming files via Bluetooth
regardless of paired devices, you
can choose to accept or reject the
connection, after checking the
sender details.

3. Search and pair new device
<Searching new device>
You can search new device as
following menu.
• Menu > 9. Settings >
4. Connectivity >
1. Bluetooth >
2. Paired devices

Settings

- My name: You can name or
rename your phone as it will
appear on other devices. Your
phone's name will be shown on
other devices only when [My
handset’s visibility] is set to [Show].

Note
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Settings
<Pairing devices>
1. To search for a Bluetooth device to
pair, press New.
2. Screen shows Searching for
devices. Bluetooth devices within
a range of 10m will be found.
3. If Bluetooth devices are found,
these devices are listed on the
screen. If no Bluetooth device is
found, you will be asked if you
want to search again.
4. Pairing procedure
- Press . A window will appear
on the screen asking you to enter
your password.
Settings
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- After creating a password (of 1
to 16 digits), the user of the
other device must enter the
password for pairing.

The user of the other device
must know the password in
advance for authentication.
] KG290 supports follow Bluetooth

services
- Headset profile
- Hands-free profile
- Object push profile
- Serial port profile
- File transfer profile
- Dial-up networking profile

Option
] Connect

1. If you want to open the
connection to the selected
device, select the Connect.
2. If you want to close the
connection to the selected
device, select the Disconnect.

] New: Using this menu, you can

pair a new Bluetooth device with
your phone.
] Remove: Using this menu, you

can delete the paired Bluetooth
device.
] Remove all: Using this menu, you

can delete all of the paired
Bluetooth devices.
<Removing devices>
1. Select a device to remove from
the Paired devices screen.

1. To transmit data from your phone
to another Bluetooth device, first
select the application where the
target data is saved. For example,
to send data in the My stuff to
another device, select
Menu > 6. My stuff > 1. Images
/ 3. Videos / 4. Others > Select
from option menu, Send via >
Bluetooth
2. Transmitting data
1) Paired device found is
displayed. If the desired device
does not exist in the list, select
[Options > New].
2) Select the device to which you
want to transmit data from the
devices on the screen and press
.

Settings

2. You can remove a device by
pressing the Delete key or by
selecting Options > Remove.
To remove all paired devices,
select Options > Remove All.

<Transmitting data using
Bluetooth>
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Settings
3) If the other party selects [Yes]
for [Connection request], the
data is transmitted.
Note
] Supported Bluetooth software

(Bluetooth stacks) for DUN :
- WIDCOMM Bluetooth for
Windows 1.4 and 3.0

Network

(Menu 9.4.2)

The Network feature enables you to
indicate whether the network used
when roaming(outside your home
area) is selected automatically,
manually or preferably.
Note
Settings
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] You can select a network other than

your home network only if it has a
valid roaming agreement with your
home network.

Network selection

(Menu 9.4.2.1)

Automatic
Use this to set the phone to
automatically search for and select
one of the networks available in your
area.
Manual
If you want to select the desired
network manually from a list of
networks, you can activate this
function. If the connection to the
manually selected network is lost,
the phone will give off a error tone
and ask you to select a network
again. The selected network must
have a roaming agreement with your
home network. The phone will let
you select another network if the
phone fails to access the initial
selected network. The phone will

default back to Automatic if it is
switched off.
Preferred
You can set a list of preferred
networks and the phone attempts to
register with first, before attempting
to register to any other networks.
This list is set from the phone’s
predefined list of known networks.

Change frequency band

(Menu 9.4.2.2)

America(1900)
Allows you to select America(1900)
only depending on Network
availiablilty.

Access point
(Menu 9.4.2.4)
Allow you to select the access point
from the list.

USB connection mode

(Menu 9.4.3)

You can activate USB connecton
mode of your phone for serveral
usages.
If you use Mass storage function like
USB memory card, select Mass
storage in this menu. Mass storage
is available for only external memory
card.
If you use Data service such as PC
suite application, select Data service
in this menu.

Settings

Europe(900/1800)
Allows you to select
Europe(900/1800) depending on
Network availiablilty.

GPRS attach
(Menu 9.4.2.3)
You can set GPRS service depending
on various situations.
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Settings
If you use Music sync with Windows
Media Player, select Music sync in
this menu. Music sync is available
for only music contents. If you want
to synchronise with external
memory, you can use 'External
memory' as Primary storage. If you
want to synchronise with internal
memory, you can use ‘Internal
memory’ as Primary storage.

Call
Call divert

the phone is in use.
] If no reply: Diverts voice calls

which you do not answer.
] If out of reach: Diverts voice calls

when the phone is switched off or
out of coverage.
] All data calls: Diverts to a

number with a PC connection
unconditionally.
] All fax calls: Diverts to a number

Menu 9.5

(Menu 9.5.1)

Settings

The Call divert service allows you to
divert incoming voice calls, fax calls,
and data calls to another number. For
details, contact your service provider.
] All voice calls: Diverts all voice

calls unconditionally.

88

] If busy: Diverts voice calls when

with a fax connection
unconditionally.
] Cancel all: Cancels all call divert

service.

The submenus
Call divert menus have the
submenus shown below.
] Activate: Activates the
corresponding service.

- To voice mailbox: Forwards to
message centre.
- To other number: Input the
number for call diverting.
- To favourite number: You can
check recent five diverted
numbers.
] Cancel: Deactivate the

(Menu 9.5.3)

] Set by network: Configures with

the default settings determined by
the service provider.
] On: Configures to send my phone

number when making an outgoing
call.
] Off: Configures not to send my

corresponding service.
] View status: View the status of

the corresponding service.

Answer mode

Send my number

phone number when making an
outgoing call.

Call waiting
(Menu 9.5.2)

service. Selecting this item,
displays requesting message and
animation. When the network
answers, the result of the
operation is displayed.

Settings

Allows you to set the answering
method. You can choose between
Slide open, Any key and Send
key only.

(Menu 9.5.4)

] Activate: Activates call waiting
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Settings
] Cancel: Deactivates Call waiting

service. Selecting this item
displays requesting message and
animation. When the network
answers, the result of the
operation is displayed.
] View status: Displays activated

Call waiting service group item of
the network. Selecting this item
displays requesting message and
animation. When the network
answers, the result of the
operation is displayed.

Minute minder
Settings
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(Menu 9.5.5)

Determines whether to sound a 1
minute tone every 1 minute when
you are on the phone.

Auto redial

(Menu 9.5.6)

Allows you to set the auto redial
function when a call attempt has
failed.

Select line

(Menu 9.5.7)

(SIM dependent)
This menu is shown only if the SIM
supports two subscriber numbers,
that is, two phone lines. Select
which phone line (between Line 1
and Line 2) you want to use for
making calls and sending short
messages. Calls on both lines can be
answered irrespective of the
selected line.

Send DTMF tones

(Menu 9.5.8)

DTMF tones allow your phone to
make use of an automated
switchboard.

Security
PIN code request

Menu 9.6

(Menu 9.6.1)

In this menu, you can set the phone
to ask for the PIN code of your SIM
card when the phone is switched on.
If this function is activated, you’ll be
requested to enter the PIN code.
1. Select PIN code request in the
phone settings menu, and then
press
[OK].

5. You can enter your PUK code up to
10 times. If you enter the wrong
PUK code more than 10 times, you
can not unlock your phone. You
will need to contact your service
provider.

Auto key lock

(Menu 9.6.2)

If you activate this function, the
keypad will be locked automatically
after predefined delay time when the
slide is closed.

2. Set On/Off.
3. If you want to change the setting,
you need to enter PIN code when
you switch on the phone.

(Menu 9.6.3)

You can lock your phone.
The following 4 lock functions are
available.
Off: Deactivates the lock function.
When power on: Locks the handset
whenever the handset is switched
on.

Settings

4. If you enter the wrong PIN code
more than 3 times, the phone will
lock out. If the PIN is blocked, you
will need to key in the PUK code.

Phone lock
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Settings
When SIM changed: Locks the
handset when the phone's SIM card
has been changed.
Immediately: Locks the handset
immediately.
You are requested to enter the
security code to confirm the
selection.
] To unlock the handset, you need to

enter the security code.

Call barring

(Menu 9.6.4)

1. All outgoing

Settings
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When
is selected, it receives
the Barring password from user,
and activates the barring service
on the network. A requesting
message and animation appears.
When the network answers,

the result of the operation is
displayed.
2. Outgoing international
When
is selected, it operates
in the same way as the Outgoing
calls menu.
3. O/G international except home
country
When
is selected, it operates
in the same way as the Outgoing
calls menu.
4. All incoming
When
is selected, it operates
in the same way as the Outgoing
calls menu.
5. Incoming when abroad
When
is selected, it operates
in the same way as the Outgoing
calls menu.

Select the Activate menu to
receive the Barring password from
the user and activate the barring
service on the network.

Fixed dial number

The Cancel menu sets
the selected call restriction off.
The View status menu enables
users to view the current network
configuration. Selecting View
status menu displays the
Requesting message with
animation and the result of the
operation when the network
answers.

] Number list: Displays the current

6. Cancel all barrings

7. Change password
You can change the password for
Call Barring Service.

activate or not. PIN authentication
is required.
Fixed dialist. You can edit, add, or
delete fixed dial numbers. PIN2
authentication is required to edit
the list. And the configuration
information is saved on the SIM.

Change codes

(Menu 9.6.6)

You can change the PIN, PIN2,
Security code.

PIN code
PIN is the abbreviation for Personal
Identification Number, and is used to
restrict use by an unauthorised user.

Settings

You can cancel all barring
services.

(Menu 9.6.5)

] ON/OFF: Select whether to
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Settings
PIN code change procedure
1. Select ‘PIN code’ from the
‘Change codes’ list and then
press .
2. Enter the current PIN code and
press .
3. Enter the new PIN code and
press .
4. Enter the new PIN code once
again and press .
] If the PIN code is different from

that of step 3, the procedure is
restarted from step 3.

Settings
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5. When the PIN code is changed
properly, a Changed message is
displayed. If you enter an incorrect PIN
code in step 2, the procedure is
restarted from step 2, and the number
of attempts you have left to enter the
number is decreased by 1.

Note
] Three incorrect PIN code entries in

the PIN code entry window would
invalidate the PIN code.
In this case, you have to enter the
PUK (PIN Unblock Key) code to
configure the PIN code again. The
maximum number of times you may
enter the PUK code is 10. (Note: If
you enter an incorrect PUK code 10
times, the SIM card will be blocked
and must be replaced.)

PIN2 code
PIN2 is the abbreviation for Personal
Identification Number 2, and is used
to restrict use by unauthorised users
as with the PIN.
The PIN2 code change procedure is
the same as the one for the PIN
code. 3 incorrect PIN2 code entries
would invalidate the PIN2 code.

In this case, you have to enter the
PUK2 code in order to use the PIN2
code again. The maximum number of
times you may try to enter the PUK2
code is 10, like PUK1. 10 incorrect
PUK2 code entries would invalidate
the PIN2 code.

Security code
The security code is used to change
the mobile phone password. The
maximum number of attempts to
enter the security code is not limited
as it is with PIN2.

Flight mode

Menu 9.7

If you acivate the Flight mode, you
can use the phone without
connecting the 2G wireless network.
2G wireless phone and FM radio
signals from the phone or Bluetooth
connections are prevented, but you
can still do tasks which do not
require the use of wireless network.
With flight mode you cannot make
any calls including emergency calls
or use other features that require
network service.

Settings
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Settings

Power save

Menu 9.8

Decide whether to activate the
power save mode or not.

Reset

Menu 9.9

You can initialise all factory defaults.
You will need the Security code to
activate this function.

Memory status

Menu 9.0

You can check the status of memory
in use.

Settings
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Accessories
There are various accessories for your mobile phone. You can select these
options according to your personal communication requirements.

Standard Battery

Travel Adapter
This charger
allows you to
charge
the battery
whilst away
from home or
your office.

Portable Handsfree

Note

This connects to
your phone,
allowing
handsfree
operation.

] Always use genuine LG accessories.
] Failure to do this may invalidate your

different regions; please check with
our regional service company or
agent for further inquires.

Accessories

warranty.
] Accessories may be different in
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Technical data
General
Product name : KG290
System : GSM 900 / DCS 1800 / PCS 1900
Net weight : 54.5g(Without battery)

Ambient Temperatures
Max : +55°C (normal), +45°C (battery charging)
Min : -10°C

Technical data
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MEMO

MEMO
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